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Chapter 2: 

Using Multiple Worksheets in a Model 
 

Objectives 
This chapter is intended to expand on the features of Excel introduced in the 

demonstration models of Chapter 1.  As the title implies, a general objective of the 

chapter is for you to understand why multiple worksheets are used in a model and how 

these can be related to each other by the use of formulas which use data from different 

worksheets. In addition some principles of how to design a model are introduced. 

 

Here is a list of what the chapter covers: 

 naming data ranges 

 creating inter-sheet formulas  

 using more of the functions available in Excel 

 creating more charts and graphs 

 

Preparation 
Read the whole of this chapter carefully. 

 

Introduction 
This chapter consists of a number of different exercises that demonstrate the use of 

multiple worksheets in a spreadsheet model. The first few exercises lead you through 

most of the details of building the models – but as you progress fewer and fewer 

instructions are provided. It is expected that you will not simply follow the instructions 

by rote, but rather think carefully about what you are doing and why you are doing it so 

that you can apply the same principles and techniques yourself. 

 

The exercises continue to develop the use of cell range and formula naming as a means of 

clarifying the data on a spreadsheet; the use of more of the functions that are provided by 

Excel; and the use of charts to present the data. The main objective, however, is to 

understand how and why inter-sheet formulas are used. 

 

Exercise 1 - A Sales Taxes Model 
 

Open the file Exercise1 in Support Files (Chapter 2), found in Resources on the 

course website. The model consists of three worksheets – examine the Comments 

worksheet and the other two now. The Sales_Summary worksheet contains some “raw” 

data and some headings where data is to be calculated. The Tax_Rates worksheet 

contains just the two values for GST and PST rates (pre-HST in Ontario, or pretend you 

live in B.C.) – values that rarely change. Your task in this exercise is to complete the 
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model – i.e. to create formulas so that the Sales_Summary worksheet looks like Figure 

2.1. 

 

 

Figure 2.1 – the completed Sales_Summary worksheet 
 

 
 

Naming Data Ranges 
The Cost column is just the price each multiplied by the quantity for each item listed. 

One simple way to create the formula for the cost is to follow the steps shown next. 

Observe the formula bar as you do this in order to see the formula as it is built. 

 

 Select the first cell in the Cost column 

 Type an = symbol to begin specifying a formula 

 Click in the first cell in the Price Each column 

 Type an * (the multiplication operator) 

 Click on the first cell in the Quantity column 

 Press the Enter key 

 

You could then fill this formula down the Cost column. However, because it uses just the 

default cell naming conventions of Excel (=B2*C2) the formula is really quite difficult to 

understand. If the model were large it would be very difficult to understand a formula like 

this. It would be much better if the formula for cells in the Cost column appeared as: 
 

Price Each * Quantity 
 

You can make this happen by naming the cell ranges. In Excel 2003, first select the data 

in the Price Each column and then choose Name/Define from the Insert menu command. 

The window shown in Figure 2.2 should appear. Notice that a name has been chosen for 

you based on the column heading except that the space in Price Each has been replaced 
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with the underscore ( _ ) symbol because spaces are not valid characters in names. Often 

the name chosen for you will be acceptable; but you are free to change it if you wish. 

 

First select the data in the Price Each column and then select the Formulas tab, and inside 

that select the Define Name command found in the Defined Names group. A window 

similar to the one shown in Figure 2.2 should appear. The differences are that the Title 

bar shows New Name instead of Define Name, Name and Scope: Workbook instead of 

Names in workbook:, and two buttons (OK, Cancel) instead of four buttons. Otherwise, 

this window behaves in the same way as in Excel 2003. 

 

Figure 2.2 – the Define Name window 
 

 
 

Notice too the Refers to: text box in which the cell references specifying the column of 

data appear. The reason why there are $ symbols in the data range specification is 

discussed below in the section titled Absolute versus Relative Cell References.  

 

You can carry out the same sequence of operations in order to name the column of 

Quantity data – i.e. select the Formulas tab, and inside that select the Define Name 

command found in the Defined Names group, and click on the OK button. 

 

Now return to constructing the formula for the Cost column of data. First delete the 

formula you created previously for the first cell. Make sure the first cell is selected and 

create the formula: 

 Type an = symbol 

 Click on the Formulas tab and then select Use in Formula found in the Defined 

Names group and select Price_Each from the list. 

 Type * (the multiplication operator) 

 Choose Quantity from the list of names produced by clicking on Use in 

Formula. 

 Press the Enter key 
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Making sure the first cell is selected drag the fill handle down the column to fill the other 

cells with this formula. (Remember that the fill handle is the lower right corner of the 

active cell - the one with the black border - and the cursor changes to a cross (+) when it 

is positioned correctly to do the drag operation.) Clearly this formula makes much more 

sense to the reader (either you yourself or someone else) now that names are used. 

 

Make sure that the column of numbers is properly formatted as currency. 

 

Calculating the PST Column 
The PST column could be created by the following steps – perform them now and see if 

you can understand the results. 

 Select the first cell in the PST column and type an = symbol 

 Click on the first cell in the Cost column 

 Type an * (multiplication operator) 

 Click on the Tax_Rates worksheet tab, and then on the value for PST in that 

worksheet (notice as you do this how the worksheet name appears in the 

formula you are creating), and then press Enter. 

 Fill this formula down the column 

 

You probably have a spreadsheet resembling Figure 2.3, in which most of the values in 

the PST column are clearly wrong. What is the error here? 

 

Well examine the formulas carefully one by one. The formula in the first cell is 
 

=D2*Tax_Rates!B3 
and in the second cell it is: 

=D3*Tax_Rates!B4 
 

Notice that D2 in the first formula refers to the first cell of the Cost column and that D3 

in the second formula refers to the second cell of the Cost column, which is what we 

want. However, while Tax_Rates!B3 in the first formula is the correct cell reference for 

the PST value, it has been changed to Tax_Rates!B4 in the second formula. 

 

The third cell has the formula: 
 

=D4*Tax_Rates!B5 
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Figure 2.3 – Incorrect results from relative cell references 
 

 
 

The D4 cell reference is correct – it refers to the 3
rd

 cell in the Cost column, but the 

Tax_Rates!B5 cell reference refers to an empty cell! 

 

Not only have the cell references for the Cost column been adjusted when the formula 

was filled down the column, but the PST cell reference, which should have been fixed, 

has also been adjusted relatively. 

 

Absolute versus Relative Cell References 

This kind of error can be fixed by typing the $ symbol as a prefix to either the letter, or 

the number, or both, in a cell reference. The $ symbol makes the reference (the column, 

row or both) absolute, which means that when the formula is filled the cell reference will 

not change. 

 

 If the column reference of a cell is made absolute (e.g. $F10) then when a formula using 

such a reference is filled across a row the cell referred to remains constant, but if the 

formula is filled down a column the cell referred to changes (to $F11, $F12 etc). Make 

sure you understand this point by experimenting with it.  

 If the row reference of a cell is made absolute (e.g. F$10) then when a formula using such 

a reference is filled across a row the cell referred to changes (to G$10, H$10 etc), and if 

the formula is filled down a column the cell referred to remains constant.  

 If both the row and column reference of a cell are made absolute (e.g. $F$10) then the 

cell referred to remains constant regardless of the fill down or fill across operation. 

 The above is true for copying and pasting or cutting and pasting cells in general. Fill 

down and fill across are just specialized copy/paste operations. 
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Naming the Parameters 
One way to fix the problem with calculating the PST column is to remember to type the $ 

symbols in the formula. Select the first cell in the column, insert the $ symbols 
 

=D2*Tax_Rates!$B$3 
 

and then fill this formula down the column. The correct values will appear. 

 

A much better approach is to name the cell that contains the PST value. So select the 

Tax_Rates worksheet, and then the cell containing the PST value and choose Define 

Name in the Defined Names group inside the Formulas tab. A suitable name should 

appear automatically, so examine it and click on the OK button. Do the same for the GST 

value. Actually, in both cases the automatically generated names (PST and GST) will 

clash with names you will want for the PST and GST columns in the Sales_Summary 

worksheet, so alter the names to PST_Rate and GST_Rate as you define them. 

 

Clear the formulas for the PST column in the Sales_Summary worksheet (select the 

cells and choose Clear All from Clear, found in the Editing group inside the Home tab), 

and recreate the formula using the names you have just defined. Create the formulas for 

the GST column in the same way. 

 

The Total Column 

The data in the Total column should be calculated by a formula: 
 

= Cost + PST + GST 
 

which is filled down the column. Define the names necessary to do this and finish 

building the spreadsheet model so that the results match Figure 2.1. 

 

Exercise 2 - A Retail Store Budget Model 
 

You may have thought to yourself: 

 “I don’t need to name these things – in fact it’s much simpler just to 

type 0.08 for GST or 0.07 for PST directly in the formula. Why bother 

with putting these values on another worksheet and referring to them  

in the formulas?” 

 

Well, hopefully this next model will answer that question for you. Open the file called 

Exercise 2a in Support Files (Chapter 2) and read the Comments worksheet. 
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Figure 2.4 – the Retail Store Budget model 
 

 
 

Changing the Model Parameters 
The model shows estimated sales for two types of goods by a retail store, and then 

various amounts that must be subtracted from the total sales revenue to arrive at a 

surplus/deficit figure. 

 

One type of deduction is for amounts remitted to government for sales taxes and payroll 

taxes. Sales taxes are calculated from total sales, which are assumed to include the taxes 

(being cash register receipts, for example). Payroll taxes are a percentage (7%) of the 

salaries paid to employees. Other deductions are for actual costs – for advertising, 

wholesale cost of goods, lease, payroll etc. 

 

The government has just delivered a budget in which the provincial sales tax has changed 

to 9% and the payroll tax has changed to 6%. The franchiser decides to change their fee 

to a flat rate of $12,000 plus 5% of total sales. Can you modify the worksheet to 

incorporate these changes? Go ahead and try. 

 

No doubt you will carefully study the formulas in an attempt to make sense of the various 

figures contained in them in an effort to decide which values you need to change. This is 

not so easy - as you will discover. 
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On the other hand, open the file Exercise 2b in the Support files (Chapter 2) and try 

making the changes in this model. You should find it much easier. 

 

Adding to the Retail Budget Model 
The purpose of a spreadsheet is often to simulate some problem situation. Here in this 

exercise 2 model the simulation is of a microeconomic nature – budgeting for a retail 

store. The owner might be interested in how many hours on a Sunday the store might be 

able to open and what effect that would have in terms of payroll costs versus extra sales. 

Would it be worth it to open on a Sunday? 

 

Currently the data in the payroll row is an estimated value entered as “raw data” onto the 

worksheet. But the figure really represents the end result of a staffing model. The staffing 

model might consist of a number of sales persons at 8 or 10 hours per day on weekdays, 8 

sales persons on Saturdays for 10 hours and 3 salespersons on Sundays for 4 hours. The 

hourly pay might be $9.50 for salespersons. In addition there might be a supervisor or 

two at all times, at an hourly pay of $15.00. 

 

Clearly those three figures in the Payroll row represent a lot of information. Why not 

incorporate all of this modeling in another worksheet which will provide the data from 

which the payroll figures can be calculated? This section will step you through this task. 

 

Adding a Worksheet 

First you need a new worksheet – the fourth in this model. Click on the Insert Worksheet 

icon, next to the last worksheet tab. The new sheet is inserted to the right of the last sheet.  

You can drag the new sheet to position it wherever you like – to the right of the 

Q1_Budget worksheet would be best. 
 

 
 

Building the Staffing Model 

Rename the new worksheet StaffingModel and then construct it roughly like Figure 2.5. 

To do this you will need to add to the Parameters worksheet values for the labour costs 

– namely an hourly pay rate for sales persons and an hourly pay rate for supervisors. The 

Number and Hours rows contain “raw data” but the Amount row is calculated using the 

hourly pay rate (from the Parameters worksheet) and the total number of hours. The 

Total Payroll Costs per Week is also calculated from the data in this worksheet.  

 

The Payroll line in the Q1_Budget worksheet can now use this figure for weekly payroll 

costs to calculate the monthly payroll cost (because there are more than 4 weeks in a 

month you should multiply by about 4.2). Construct the formula to compute the monthly 

payroll in the Q1_Budget worksheet and fill it across the three months. The part of the 

Q1_Budget worksheet dealing with the weekly payroll will now look as follows: 

Inserting the new sheet: 
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Figure 2.5 – the Staffing Model worksheet 
 

 
 

Commentary 
Before adding this StaffingModel worksheet it was not possible to easily see the effect of 

a realistic payroll amount on the budget model. Now, not only can you see the effect of 

adjusting hours worked on any day of the week, or changing the number of employees on 

any day, but you can also see the effect of adjusting hourly pay rates. (Hopefully you 

could afford to pay your employees better!) In terms of modeling a problem it is far more 

effective to replace raw data with some method of calculating such data. 

 

Of course, the model is still far from realistic. For example, you might want the sales 

figures in the Q1_Budget worksheet to be computed rather than just entered. To 

construct a model that accounts more realistically for the processes involved can become 

very complex. 

 

Exercise 3 - A Gas Equation Model 
 

The pressure, volume, and temperature of a fixed amount of gas are related to each other. 

If you have a closed container (i.e. the volume cannot change) and you heat it the 

pressure will increase. On the other hand if you have a container whose volume can 

change and, keeping the temperature constant, you increase the volume then the gas 

pressure inside will decrease. 
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According to one model of these physical phenomena the quantities are related by PV = 
nRT, where P is the pressure, V is the volume, n is the amount of gas, R is a quantity 

called the gas constant and T is the temperature. This is called the ideal gas equation. It 

assumes that gas molecules behave “ideally”, which means that they bounce around 

inside the container without influencing each other except when they collide, and then 

they behave like very small hard balls. 

 

Another model relates these quantities by the equation (P + n2a/V2)(V - nb) = nRT. This 

is called the van der Waals equation and it attempts to take account of the fact that there 

are forces of attraction between gas molecules, and that the molecules themselves occupy 

a certain volume. The parameters a and b are constants that are determined by 

experiment and that are different for different gases. For chlorine gas, which we will 

model, the value of a is 6.49 liter
2
atmosphere/mole

2
 and the value of b is 0.0562 

liter/mole. 

 

You need not understand the physical phenomena underlying these models. But you must 

understand the techniques of implementing a model using the spreadsheet. We would like 

to keep n and T constant and to calculate P as we vary V, for example. We hope to see if 

P as predicted by the van der Waals equation is very different from P as predicted by the 

Ideal Gas equation. 

 

The question is how should we design our spreadsheet model? Give this some thought 

before reading on. Answer for yourself how you would arrange the data into worksheets 

to create a flexible model. By flexible, we mean that certain numbers – the temperature or 

n, for example – can be easily changed. 

 

The Main Data Worksheet 
You want to calculate P for a whole lot of values of V (other things being held constant). 

This means you should have a column in your worksheet to contain the different values 

of V – perhaps the first value for V will be 0.5 (meaning 0.5 liter) and the next will be 

0.52, and then 0.54 etc for perhaps 50 or so values. 

 

Do this now. Launch Excel (or close other workbooks and create a new one if Excel is 

already running), rename Sheet1 to Comments and type a brief explanation of what 

you are about to do, as best you can at this point. Rename Sheet2 to PressureVolume. 

Now type a column heading – Volume – and format it in some way, then the type first 

value (0.5) and select down the column for about 50 cells. You are going to fill these 50 

cells with the series of volume numbers. So, choose Series… from the Fill command 

menu, found in the Editing group inside the Home tab, and change the step value to 0.02. 

(Refer back to the cosine function exercise in Chapter 1 if you need further guidance 

doing this.) 
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The Ideal Gas Calculation of P 

Next you’ll want a column for P as calculated by the Ideal Gas equation – so type a 

suitable column heading and format it. Now you need to enter the formula that calculates 

P, namely: 

P = nRT/V 
 

You have values for V, but you also need values for n, R and T. We might want to 

change n and T but R can never change – it is one of those physical constants like g the 

gravitational constant. Despite this difference between n and T compared to R we should 

probably enter all three on a third Parameters worksheet. So change the name of 

Sheet3 to Parameters and type headings for the values and enter 0.2 for n (being 0.2 

moles of gas), 0.082057 for R (the units are litre atm/mole/degreeK) and 200 for T (being 

in units of degrees Kelvin). 

 

Give names to these values using, Define Name in the Defined Names group inside the 

Formulas tab. Before you proceed to create the formula that calculates the P values you 

should also define a name for the whole V column. 

 

You can now create the formula for the first P cell. It should look very similar to the 

formula given above now that you have created names for the various cells. Fill it down 

the entire P column. 

 

The van der Waals Calculation of P 

The van der Waals equation can be rearranged algebraically to give  
 

P = nRT/(V - nb) - n2a/V2 
 

Some of the parameters – namely n, R and T - are already available in the Parameters 

worksheet, and now you must add the two van der Waals constants, a and b, whose 

values for chlorine gas were given previously. When you add these values to the 

Parameters worksheet be sure to give them names that you can use in the formula. 

 

Your Parameter worksheet should look something like that shown in Figure 2.6 after you 

have formatted things nicely. 
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Figure 2.6 – the Parameters worksheet for the Gas Equation model 
 

 
 

Next you need to calculate the pressure using the van der Waals equation. Create a 

suitable column heading in the PressureVolume worksheet, create the formula for P 

according to the van der Waals equation, and fill the formula down the column.  

 

Figure 2.7 – a portion of the PressureVolume worksheet 
 

   
 

Creating a Graph 

The table of numbers is not very helpful in comparing the results of the two equations. It 

would be very much easier to see the differences if we create a graph. Review the section 

Creating a Graph from the cosine function exercise in Chapter 1, which explains in some 

detail the steps involved. The instructions here are deliberately minimal. 

 

There will be two lines on this graph – one for the ideal gas calculation of P and the other 

for the van der Waals calculation of P. These two lines and the data they represent are 

called series. In Select Data, for the first series you add under Legend Entries (Series) 
select the data for the ideal gas pressure calculation, and give it a name such as Ideal 
Gas. This name will appear in a legend identifying the line on the graph that represents 

this calculation of the pressure. Next add another series for the van der Waals gas 

pressure calculation and give it the name van der Waals. Under Horizontal (Category) 
Axis Labels, select the data you would like to use for the horizontal axis – in this case it 

will be the column of Volume data. This window should end up looking like Figure 2.8. 

 

 

 



COSC1520.03  The Glade Manual  

Computer Use: Fundamentals 

 

 

 

 

 

 

 2-13 

Figure 2.8 – naming the series and specifying the X axis data 

 

 
 

This time the standardized Chart Layouts will not be used. The remaining components 

of the chart will be created one-by-one. The creation of the chart title, the two axes titles, 

switching off all gridlines, and positioning the legend at the bottom can be accomplished 

by selecting the Chart Tools/Layout tab and then clicking on Chart Title, Axis Titles 

(twice), Gridlines and Legend respectively, and choosing from the menus in each case. 

 

The graph had been originally placed on the PressureVolume worksheet. Choose Move 

Chart Location in the Chart Tools/Design tab to place the chart on the Parameters 

worksheet. 

 

 
 

Continue to “fine tune” the chart by changing its size, positioning it appropriately with 

respect to the data in the Parameters worksheet, changing the font sizes for the title and 

axes titles, and changing the tick marks and labels displayed on the axes. Also make one 

of the lines on the graph a dashed line, by the normal method of selecting it by double 

clicking on the line itself and then choosing from the options available to you (Line 

Style).  
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Figure 2.9 – the Gas Equation graph 

 

 
 

Commentary 
Having placed the graph on the parameters worksheet you are easily able to compare the 

two equations when you change the parameter values. Try changing T or n for example to 

see the effect. You can also change a or b but the results will not then be for a real gas 

since the values given are specifically for chlorine gas. 

 

 

Exercise 4 - The Cobb-Douglas Model 
 

This next exercise is fundamentally the same as the previous, although in a different 

context. Consequently, the instructions will be somewhat briefer. 

 

Economists have found that the output of a firm is often related to the level of investment 

in labour and machinery, and is given by the equation: 
 

S = f La_labour Ma_machinery 
 

where S is the output supply, L is the investment in labour, M is the investment in 

machinery, f is a constant, and a_labour and a_machinery are the so called elasticities 

of production for labour and machinery. 

 

Typically, total capital investment can be expressed as: 
 

K = eL + M 
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where the coefficient e (a constant) implies that a unit of investment in labour is 

equivalent to more or less than a unit of investment in machinery depending on whether e 

is greater than or less than 1. 

 

These two equations suggest that given a total investment K, it can be split between 

investments in labour and machinery, and that it should be possible to choose investments 

in L and M in such a way as to maximise output supply S. 

 

The spreadsheet model we develop will investigate this graphically. We will plot L on the 

vertical axis and M on the horizontal axis for both of these equations – that is we will plot 

L as a function of M where in one case L is given by 

L = (S / (f Ma_machinery))1/a_labour 
and in the other by 

L = (K - M) / e 
 

S and K will be parameters, meaning that we will perhaps choose a value for the output 

supply, S, that we want to achieve and adjust total investment K to try to minimise it 

while achieving output supply S. The values a_machinery, a_labour, f and e will be 

constants. 

 

Creating the Data Worksheets 
You’ll need a Comments worksheet, a Parameters worksheet and a Data worksheet.  

 

Write a short explanation in the Comments worksheet as best you can at this point, and 

remember to come back to expand on it after you have completed the model and 

understand it better. 

 

The Parameters worksheet will contain a_machinery, a_labour, f and e with values 

1.0, 1.2, 0.1 and 0.75 respectively. It will also contain values for K and S – say 60 and 50 

to begin with. In addition, the Parameters worksheet will contain the graph. Layout this 

worksheet now, leaving room for the graph. Make sure you format it nicely and that you 

name the various cells containing data for use later in formulas. 

 

The Data worksheet will contain three columns – one for M values (say 40 values 

starting at 0 with a step of 2), one for L as calculated using the output supply formula and 

one for L as calculated using the total investment formula. Part of the Data worksheet is 

shown in Figure 2.10. Notice that the first cell in the L(S) column is empty. Make sure 

you do the calculation for this cell to see what happens (why does it happen?) and then 

clear the contents of that first cell. 
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Figure 2.10 – part of the Cobb-Douglas Data worksheet 
 

 
 

Creating the Graph 
Construct a graph with the two series L(S) and L(K) and with M as the X-axis values. 

Figure 2.11 shows how the graph might look after you have fine-tuned it. 

 

Notice that the vertical axis does not extend to negative values, which your graph will 

until you correct it. Make sure you figure out how to set the axis to prevent the negative 

values. 

 

Figure 2.11 – the Cobb-Douglas Parameter worksheet 
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Modeling Output Supply 
So what does this graph tell us? It says that if total investment is K=60 units then output 

supply of S=50 units can be achieved in two ways. Those two ways are represented by 

the points of intersection of the straight line and the curve. One way is to invest about 56 

units in machinery and about 10 units in labour – this is the right hand point of 

intersection. The other way is to invest about 5 units in machinery and about 80 units in 

labour, which is the left-hand point of intersection. 

 

But you can reduce total investment K and still achieve output supply of S = 50. Try it 

now – change K to say 40. You’ll see that there are still two ways of achieving the output 

supply, which implies that you could reduce K further. Try setting K=20, for example. 

This has gone too far since the lack of an intersection implies that there are no possible 

values of investment in labour and machinery which will achieve S=50 when K=20.  

 

The smallest total investment K will be the value that results in the line intersecting the 

curve in only one place. What is this minimum value of K? 

 

You could also reset K=60 and then see what maximum output supply can be achieved. 

What is the maximum Output Supply that can be achieved with a total investment of 60? 

 


